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CHAPTER ONE  

1.0 INTRODUCTION 

1.1 BACKGROUND 

The quest for preserving food while maintaining its quality has led to the exploration of natural 

alternatives to synthetic preservatives. In the realm of bread production, calcium propionate has 

been a widely used synthetic preservative due to its effectiveness in inhibiting mold growth(Alam 

et al., 2010). However, with the rising consumer demand for clean-label products and natural 

ingredients, there is a growing interest in utilizing natural preservatives such as rosemary extract 

and lemon juice (Tzima et al., 2015). These natural alternatives not only extend the shelf life of 

bread but also align with health-conscious consumer preferences. Bread is a staple food consumed 

globally, and its preservation is crucial for reducing food waste and ensuring safety. Traditional 

preservatives like calcium propionate work by disrupting the metabolism of mold spores, thereby 

preventing spoilage (Garcia & Copetti, 2019). However, concerns regarding the long-term health 

effects of synthetic additives have prompted researchers and manufacturers to seek safer 

alternatives. Natural preservatives, derived from plant extracts and organic acids, offer a promising 

solution. For instance, rosemary extract contains carnosic acid, which has demonstrated 

antimicrobial properties effective against various spoilage organisms (Bakerpedia, n.d.). Similarly, 

lemon juice, rich in citric acid, not only enhances flavor but also lowers pH levels, creating an 

unfavorable environment for microbial growth (Chemsino, 2024). The use of rosemary extract and 

lemon juice as natural preservatives presents several advantages. These ingredients are not only 

effective at prolonging shelf life but also enhance the sensory qualities of bread. The incorporation 

of rosemary can impart a unique flavor profile while providing antioxidant benefits (Whole Grain 

100, n.d.). Lemon juice contributes acidity that can improve the overall taste and texture of bread 

while acting as a natural preservative (Reddit AskCulinary, 2022). Moreover, the shift towards 

natural preservatives aligns with consumer trends favoring healthful eating habits and transparency 

in food labeling. In conclusion, as the food industry evolves towards more sustainable practices, 

the exploration of natural preservatives such as rosemary extract and lemon juice represents a 

significant step forward. By replacing synthetic calcium propionate with these natural alternatives, 
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bread manufacturers can meet consumer demands for healthier options without compromising 

product quality or safety. 

1.2 Problem Statement 

The widespread use of synthetic preservatives like calcium propionate in bread production, while 

effective in inhibiting microbial spoilage and extending shelf life (Belz et al., 2012; Phechkrajang 

& Yooyong, 2016), faces increasing scrutiny due to consumer preference for natural and clean-

label alternatives (Namanya Jonan, 2024). Concerns regarding potential health implications 

associated with synthetic additives (Ossenkopp et al., 2012; Arooj Attique, 2018) have driven the 

search for natural preservatives that can offer comparable efficacy without the perceived 

drawbacks. Rosemary extract, rich in antioxidant and antimicrobial compounds such as carnosic 

and rosmarinic acids (Ataman Kimya, n.d.), and lemon juice, containing citric and ascorbic acids 

known for their antimicrobial properties (Teixeira et al., 2019; EFSA, 2015), have emerged as 

promising natural alternatives. However, their performance in bread preservation, particularly in 

direct comparison to calcium propionate, requires thorough investigation to determine their 

optimal application levels and impact on bread quality attributes. Therefore, this study seeks to 

address the gap in knowledge regarding the comparative efficacy of rosemary extract and lemon 

juice against synthetic calcium propionate in preserving bread and maintaining its quality 

characteristics throughout its shelf life. 

1.3 Objectives of the Study 

The primary objective of this study is to evaluate the performance of rosemary extract and lemon 

juice compared to synthetic calcium propionate as bread preservatives.  

1.31 Specific objectives  

1. To determine the optimal concentrations of rosemary extract and lemon juice for the best 

dough quality. 

2. To assess the impact of rosemary extract and lemon juice on the texture, aroma, taste and 

tenderness of bread compared to calcium propionate.  

3. To Compare Shelf Life of bread treated with rosemary extract and lemon juice against 

that of bread treated with calcium propionate. 
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1.4 Justification 

The growing consumer demand for natural and clean-label food products, coupled with the need 

for effective and safe alternatives to synthetic preservatives in the baking industry is a key driver 

for the study. While calcium propionate is a widely used and effective synthetic preservative, 

concerns regarding its potential health implications and consumer preference for natural 

ingredients necessitate the exploration of plant-based alternatives. Rosemary extract and lemon 

juice possess inherent antimicrobial and antioxidant properties, suggesting their potential as 

natural preservatives in bread. Evaluating their performance against a benchmark synthetic 

preservative like calcium propionate will provide valuable insights into their efficacy in extending 

shelf life, maintaining bread quality, and meeting consumer expectations for more natural food 

options. This research contributes to the development of healthier and more sustainable food 

preservation strategies. 

 

1.5 Significance 

Firstly, the study addresses the increasing consumer preference for natural and minimally 

processed foods by investigating plant-derived alternatives to synthetic preservatives in a staple 

food like bread. Successful identification of rosemary extract and/or lemon juice as effective 

preservatives could offer the baking industry natural solutions to extend product shelf life and 

reduce food waste, aligning with sustainability goals. Secondly, the study contributes to scientific 

knowledge by comparatively evaluating the preservative efficacy of these natural extracts against 

a well-established synthetic compound, providing valuable data on their antimicrobial and 

antioxidant mechanisms in a food matrix. This information can inform future research and 

development of other natural food preservation strategies. Ultimately, the findings could lead to 

the production of bread with a cleaner ingredient list, potentially appealing to a wider consumer 

base and contributing to healthier dietary choices without compromising food safety or quality. 

1.6 Hypothesis 

Null Hypothesis 1 (HO): There is no significant impact of rosemary extract and lemon juice on 

the texture, aroma, taste and tenderness of bread. 

Null Hypothesis 2 (HO): There is no significant difference in the shelf life of bread treated with 

rosemary extract and lemon juice compared to bread treated with synthetic calcium propionate. 
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1.7 Scope of the study 

The scope of this study is limited to evaluating the effectiveness of rosemary extract and fresh 

lemon juice as bread preservatives in comparison to commercially available synthetic calcium 

propionate. The investigation will focus on assessing the impact of these preservatives on the 

shelf life of bread, specifically by monitoring changes in microbial load (mold), and selected 

quality parameters such as texture, color, and potentially aroma over a defined storage period 

under specific environmental conditions. 
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CHAPTER TWO 

2.0 LITERATURE REVIEW 

2.1 Bread shelf life 

The shelf life of bread, defined as the period during which it remains acceptable to consumers in 

terms of safety, nutritional value, and sensory attributes, is a critical factor in the baking industry, 

influencing production planning, distribution, and ultimately, food waste reduction (Cauvain & 

Young, 2007). Several intrinsic and extrinsic factors contribute to the deterioration of bread quality 

over time. The inherent composition of bread, including the type of flour, water activity, pH, and 

the presence of specific ingredients, plays a significant role in its susceptibility to spoilage (Ribotta 

et al., 2004). For instance, higher water activity levels provide a more favorable environment for 

microbial growth, while the nutritional content offers substrates for their proliferation (Legan, 

1993). 

Microbial spoilage is a primary cause of bread deterioration, significantly limiting its shelf life. 

Molds, particularly those belonging to the Penicillium, Aspergillus, and Rhizopus genera, are 

commonly found on stale bread, leading to visible growth, off-flavors, and potential health hazards 

due to mycotoxin production (Pitt & Hocking, 2009; Dal Bello et al., 2007). Bacteria, including 

Bacillus species, can also contribute to spoilage, causing ropiness, a slimy and sticky texture in the 

crumb, and unpleasant odors (Thompson et al., 1998). The initial microbial load of the raw 

materials and the hygiene practices during production and packaging significantly influence the 

rate and extent of microbial spoilage (Ledenbach & Marshall, 2009). 

Beyond microbial spoilage, physicochemical changes also contribute to the perceived staleness of 

bread. Starch retrogradation, the recrystallization of amylopectin, is a major factor leading to 

crumb firming and a loss of elasticity (Gray & Bemiller, 2003). This process is time and 

temperature-dependent, occurring most rapidly at refrigeration temperatures (Baik & Chinachoti, 

2000). Moisture migration within the loaf and between the bread and its environment also 

contributes to staling, leading to a dry crust and a firm, less palatable crumb (Heenan et al., 2004). 

Furthermore, lipid oxidation can occur, particularly in breads containing higher fat content or bran, 

resulting in rancid off-flavors and a reduction in overall quality (Frankel, 2005). 

Various strategies are employed to extend the shelf life of bread, including the use of preservatives, 

modified atmosphere packaging, freezing, and improvements in hygiene and processing 
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techniques (Smith et al., 2004). Chemical preservatives, such as calcium propionate, potassium 

sorbate, and sodium benzoate, are widely used due to their effectiveness in inhibiting the growth 

of molds and bacteria (Branen et al., 2002). However, as previously discussed, consumer demand 

for natural alternatives is increasing, prompting research into plant-derived compounds with 

antimicrobial and antioxidant properties (Carocho & Ferreira, 2013). Understanding the complex 

interplay of factors affecting bread shelf life is crucial for developing effective and consumer-

acceptable preservation strategies. 

2.2 The bread mold 

Bread mold, a common cause of spoilage in baked goods, primarily refers to filamentous fungi 

that thrive on the nutrient-rich and moist environment of bread (Pitt & Hocking, 2009). While 

various mold species can colonize bread, the most frequently encountered genera include 

Rhizopus, Penicillium, Aspergillus, and Mucor (Legan, 1993; Samson et al., 2014). These 

ubiquitous microorganisms are naturally present in the air, soil, and even on surfaces within food 

processing environments, making their contamination of bread a significant challenge in 

maintaining product quality and extending shelf life (Filtenborg et al., 1996). The visible growth 

of mold on bread not only renders it unappetizing but can also pose health risks due to the potential 

production of mycotoxins, secondary metabolites with toxic effects upon ingestion (Bennett & 

Klich, 2003). 

The life cycle of bread mold, characteristic of filamentous fungi, involves both asexual and sexual 

reproduction, although asexual reproduction is the primary mode of propagation responsible for 

rapid colonization on bread surfaces (Alexopoulos et al., 1996). Asexual reproduction typically 

begins with the germination of spores, microscopic propagules that are easily dispersed through 

air currents. Upon landing on a suitable substrate like bread, and under favorable conditions of 

temperature, humidity, and nutrient availability, these spores germinate to form hyphae, thread-

like filaments that represent the vegetative growth of the fungus (Griffin, 1994). The hyphae 

elongate and branch, forming a network called a mycelium, which spreads across the bread surface 

and penetrates its structure to absorb nutrients. 

Asexual reproduction continues through the formation of new spores. This process varies 

depending on the specific mold genus. For instance, Penicillium species produce conidia, asexual 

spores, borne externally on specialized hyphal structures called conidiophores, often giving the 
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mold a characteristic powdery or brush-like appearance (Samson et al., 2014). Aspergillus also 

produces conidia from conidiophores, which can be arranged in a more complex structure, 

sometimes forming a distinct head. In contrast, Rhizopus species reproduce asexually through 

sporangiospores, which are formed within sac-like structures called sporangia, held aloft by 

sporangiophores. When the sporangia mature, they rupture, releasing numerous spores into the 

environment, facilitating further contamination (Pelczar et al., 1993). 

While less frequently observed on the surface of visibly moldy bread, sexual reproduction can 

occur under certain environmental or nutritional stress conditions. This process involves the fusion 

of compatible nuclei from two different mating types, leading to the formation of sexual spores 

with genetic recombination (Moore et al., 2011). For example, Rhizopus species can undergo 

sexual reproduction to produce zygospores, thick-walled resting spores that can survive 

unfavorable conditions. Penicillium and Aspergillus species also have sexual stages, although they 

may not be commonly encountered in the context of bread spoilage. The resulting sexual spores 

can contribute to the genetic diversity of the mold population, potentially influencing their ability 

to adapt to different environmental conditions or preservation strategies (Bennett & Klich, 2003). 

Understanding the life cycle of bread molds, particularly their efficient asexual reproduction 

through spore dispersal and germination, is crucial for developing effective strategies to prevent 

their growth and extend the shelf life of bread products. 

2.3 Calcium propionate as a synthetic preservative  

Calcium propionate (Ca(C₃H₅O₂)₂), the calcium salt of propionic acid, is a widely employed 

synthetic preservative in the baking industry, recognized for its effectiveness in inhibiting the 

growth of molds and certain bacteria in bread and other baked goods (Sofos, 1989; коды пищевых 

добавок, n.d.). Its efficacy stems from the propionate ion, which at the acidic pH typically found 

in bread dough and the early stages of spoilage, exists predominantly in its undissociated form 

(propionic acid). This undissociated form can readily penetrate the cell membranes of 

microorganisms, disrupting their internal pH, interfering with enzyme function, and ultimately 

inhibiting their growth and reproduction (Russell & Chopra, 1996).    

The primary mechanism of action of calcium propionate against molds involves the inhibition of 

key metabolic pathways. Propionic acid is thought to interfere with the citric acid cycle (Krebs 

cycle), a central metabolic pathway for energy production in fungi (Dziezak, 1991). By disrupting 
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this cycle, calcium propionate effectively prevents the mold from obtaining the energy necessary 

for growth and spore germination. While calcium propionate is generally more effective against 

molds and some bacteria, its activity against yeasts is less pronounced, which is advantageous in 

leavened baked goods where yeast activity is essential for dough development (De Lacey et al., 

2000). 

Calcium propionate is typically added to bread dough during the mixing stage, and its effectiveness 

is influenced by factors such as the dosage level, the pH of the dough, and the overall formulation 

of the bread (Kabaca, 2007). Regulatory bodies worldwide, including the Food and Drug 

Administration (FDA) in the United States and the European Food Safety Authority (EFSA) in 

Europe, have generally recognized calcium propionate as safe for use in food at permitted levels 

(EFSA, 2011; FDA, 2023). These evaluations consider toxicological studies and establish 

acceptable daily intakes to ensure consumer safety.    

Despite its widespread use and recognized efficacy, concerns regarding the use of synthetic food 

additives, including calcium propionate, have been raised by some consumers who prefer foods 

with natural ingredients (Namanya Jonan, 2024). While scientific evidence regarding significant 

adverse health effects at typical usage levels is limited, this consumer sentiment drives the ongoing 

research into natural alternatives for food preservation. Furthermore, the effectiveness of calcium 

propionate can be somewhat pH-dependent, requiring relatively acidic conditions for optimal 

activity, which might not always be ideal for certain bread formulations or storage conditions. 

Understanding the mechanisms of action, regulatory status, and consumer perceptions of calcium 

propionate is crucial when evaluating potential natural alternatives for bread preservation. 

 

2.4 Natural preservatives 

Driven by consumer demand for cleaner labels and concerns regarding synthetic additives, the 

exploration of natural preservatives for food applications has gained significant momentum 

(Carocho & Ferreira, 2013; Decker, 2009). These natural alternatives, often derived from plants, 

animals, or microorganisms, possess inherent antimicrobial and antioxidant properties that can 

contribute to food preservation (Davidson & Branen, 2005). Examples include essential oils from 

herbs and spices like rosemary, thyme, and oregano, which contain bioactive compounds with 

broad-spectrum antimicrobial activity (Burt, 2004). 
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2.4.1 Rosemary Extract as a bread preservative 

Rosemary (Salvia rosmarinus L.) extract has garnered significant attention as a promising natural 

preservative for various food products, including bread, due to its potent antioxidant and 

antimicrobial properties (Botsoglou et al., 2003; Moreno et al., 2006). These beneficial effects are 

primarily attributed to its rich composition of phenolic compounds, particularly carnosic acid and 

rosmarinic acid, which are known for their strong radical-scavenging and antimicrobial activities 

(Schwarz et al., 1992; Valeriano et al., 2005). Carnosic acid, a diterpene, is considered one of the 

most potent natural antioxidants, capable of inhibiting lipid oxidation, a major cause of quality 

deterioration and off-flavor development in bread, especially those containing fats or whole grains 

(Frankel, 1996). Rosmarinic acid, a phenolic acid ester, also contributes significantly to the 

antioxidant capacity and exhibits antimicrobial activity against a range of foodborne pathogens 

and spoilage microorganisms, including molds and bacteria commonly found in bread (Oboh et 

al., 2010).    

The application of rosemary extract in bread production aims to extend shelf life by inhibiting both 

oxidative rancidity and microbial growth. Studies have investigated the effectiveness of rosemary 

extract in maintaining the sensory quality and reducing microbial load in bread during storage. For 

instance, some research has shown that the incorporation of rosemary extract can significantly 

delay the onset of mold growth and reduce the levels of total aerobic bacteria and fungi in bread 

compared to control samples without preservatives or even those with lower concentrations of 

synthetic preservatives (Martínez et al., 2012). The antioxidant properties of rosemary extract also 

help to preserve the color and flavor of the bread by preventing the oxidation of lipids and other 

susceptible compounds (Hsu et al., 2003).    

The optimal concentration of rosemary extract required for effective preservation in bread can vary 

depending on factors such as the specific formulation of the bread, the processing conditions, and 

the desired shelf life (Sánchez-Escalante et al., 2003). 
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2.4.2 Lemon Juice as a bread preservative 

Lemon juice, the aqueous extract of lemon fruit (Citrus limon), has been explored as a potential 

natural preservative in food systems, including bread, due to its inherent antimicrobial and 

antioxidant properties. The primary active components responsible for these effects are citric acid, 

a weak organic acid that can lower the pH of the food environment, and ascorbic acid (vitamin C), 

a well-known antioxidant (Penniston et al., 2008). The acidic nature of lemon juice, primarily due 

to citric acid, creates an unfavorable environment for the growth of many spoilage 

microorganisms, particularly molds and some bacteria, by disrupting their cellular functions and 

enzymatic activities (Lambert et al., 2001). 

The antimicrobial action of citric acid involves the permeabilization of microbial cell membranes 

and the inhibition of key metabolic enzymes, ultimately leading to cell death or growth inhibition 

(Raybaudi-Massilia et al., 2009). Ascorbic acid, while also contributing to a lower pH, acts 

primarily as an antioxidant by scavenging free radicals and inhibiting oxidative reactions that can 

lead to the deterioration of food quality, including flavor and color changes in bread (Davey et al., 

2000). The combination of these compounds in lemon juice offers a dual mechanism for 

preservation, addressing both microbial spoilage and oxidative degradation.    

However, the use of lemon juice as a bread preservative also presents certain considerations. The 

high acidity of lemon juice can potentially affect the rheological properties of the dough and the 

final texture and flavor profile of the bread (Akhtar et al., 2008). Therefore, optimizing the 

concentration of lemon juice is crucial to achieve effective preservation without negatively 

impacting the sensory quality of the bread. Furthermore, the effectiveness of lemon juice might be 

enhanced when used in combination with other preservation methods or natural antimicrobials to 

provide a broader spectrum of protection against spoilage microorganisms. Future research could 

focus on optimizing the application methods of lemon juice in bread production, exploring its 

synergistic effects with other natural preservatives, and assessing its impact on the overall 

consumer acceptability of the final product. 
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CHAPTER THREE 

3.0 MATERIALS AND METHODS 

3.1 Experimental Design 

The study employed a three-phase approach to evaluate the effectiveness of natural preservatives 

rosemary extract and lemon juice in comparison to calcium propionate. For dough optimization, a 

central composite design was used to test varying concentrations of rosemary extract and lemon 

juice. Response surface methodology was applied to identify optimal combinations based on 

measurements of dough characteristics including softness/firmness/stickiness, gluten 

development, first proof, percentage rise, texture after proofing, final proof, rise time, oven spring, 

rise after baking, visual volume, crumb texture, crust color, and flavor. Formulations that achieved 

≥85% sensory acceptance in preliminary taste panels were prioritized. 

Shelf-life assessment was conducted by storing bread samples under standardized conditions 

(25°C, 65% RH) with daily monitoring. Mold visibility thresholds were established using digital 

image analysis to quantify surface mycelium coverage. 

Sensory evaluation was carried out using triangle tests with 10 panelists to identify significant 

differences between experimental and control groups. A Likert scale was used to quantify 

consumer acceptance across aroma, taste, and texture attributes. Statistical analysis was performed 

using mixed-effects models to account for batch variations, with significance determined at 

p<0.05.  

3.2 Study Area 

The study was conducted in a home-based kitchen environment. This setting provided a controlled, 

albeit non-industrial, space for the preparation and initial storage of bread samples treated with 

different preservatives. Subsequent storage and analysis of the bread samples were carefully 

managed to maintain consistency across treatment groups within this home-based setting. 

3.3 Materials for the study 

The materials and equipment utilized in this study included all-purpose or whole wheat flour, 

water, active dry yeast or instant yeast, salt, optional sugar, and optional fat (such as butter or oil). 

Key preservatives tested were rosemary extract, lemon juice, and synthetic calcium propionate. 
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The preparation and baking processes were carried out using an oven, mixing bowls, measuring 

cups and spoons, a kitchen scale, a dough scraper, and baking pans. 

 

3.4 Procedure 

A standard white bread recipe was prepared and the dough was divided into four equal portions 

following primary fermentation. The first portion served as the control, with no added preservative. 

The second portion was treated with a predetermined concentration of commercially available 

rosemary extract, the third with a specific volume of freshly squeezed and filtered lemon juice, 

and the fourth with a calculated amount of synthetic calcium propionate. All preservatives were 

incorporated during the final mixing stage. Each dough portion was then proofed, baked under 

consistent oven conditions, and allowed to cool completely. Once cooled, the bread loaves from 

each treatment group were sliced and packaged in sterile polyethylene bags, then stored under 

controlled ambient conditions, mimicking typical household storage. Samples from each treatment 

group were collected daily for analysis. These analyses included visual assessment for mold 

growth, microbial analysis, and instrumental evaluation of texture (firmness) and color for both 

the crust and crumb. The data collected was statistically analyzed to compare the effectiveness of 

rosemary extract and lemon juice in preserving bread quality and inhibiting microbial spoilage 

relative to the synthetic calcium propionate and the control group over the storage duration of 1 

week. 

 

3.5 Data Collection 

For objective one, to determine the optimal concentrations of rosemary extract and lemon juice 

to use in bread making, making four replicates of dough per preservative. Firstly, for lemon 

juice, first replicate having no preservative, second replicate having 1.6% of lemon juice, third 

replicate having 3% and fourth having 6% of lemon juice. Then also make four replicates of 

dough with rosemary extract. First replicate being the control sample with no preservative, 

second replicate with 2.4% of rosemary extract, third with 3.6% and the fourth with 8%. To 

determine effects after baking. Then make an equal number of replicates of dough treated with 

each preservative with the control group having no preservative and then bake. 
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For objective two, to assess consumer preferences, a sensory evaluation was conducted involving 

ten panelists who rated the texture, aroma, taste, and tenderness of bread samples. Four groups 

were assessed: bread without any preservative (control), bread treated with calcium propionate, 

bread treated with lemon juice, and bread treated with rosemary extract. Ratings were recorded 

using a Likert scale ranging from 1 to 10, where 1 indicated the least preferred and 10 the most 

preferred. All data were compiled and organized in an Excel sheet for subsequent analysis. 

A. Sensory evaluation  

Tick (✔) your choice [1 (Strongly Disagree; 5 (Strongly Agree)] 

1. The bread has a desirable aroma 

 

1 2 3 4 5     6    7 8 9 10      

 

 

2. The bread has a good taste 

 

1 2 3 4 5     6    7 8 9 10      

 

3. The bread is tender. 

 

1 2 3 4 5     6    7 8 9 10      

 

4. The bread has a good texture. 

 

1 2 3 4 5     6    7 8 9 10      

 

For objective three, to compare the shelf life of bread treated with rosemary extract and lemon 

juice against bread treated with calcium propionate, four bread samples per preservative were 

baked. The first group consisted of control samples with no preservative, the second group 

contained four bread samples treated with calcium propionate, the third group included four 

samples treated with lemon juice, and the fourth group comprised bread samples treated with 

rosemary extract. All bread samples were cut down the middle to expose the inner crumb and 

stored for one week under ambient conditions. After the storage period, high-resolution 

photographs of all samples in each group were captured for mold analysis using ImageJ 

software. 
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3.6 Data Analysis 

For Objective One, dough samples were evaluated for handling characteristics, including softness, 

firmness, and stickiness, as well as gluten development, first proof, percentage rise, texture after 

proofing, final proof, rise time, oven spring, rise after baking, visual volume, crumb texture, crust 

color, and flavor under each preservative concentration. Comparative analysis was carried out and 

final notes were deduced to identify the concentration that produced the best dough quality. 

For Objective Two, sensory evaluation results from ten panelists were analyzed using One-way 

ANOVA in R Studio to determine the mean scores for texture, aroma, taste, and tenderness across 

the four bread treatment groups. 

For Objective Three, mold coverage on each bread sample replicate was measured after one week 

using ImageJ software. The data was subsequently entered into Excel, and R Studio was used to 

calculate the mean percentage of mold growth observed on the bread surfaces under each 

preservative treatment. 

Analysis of Results using Image J.  

1. Launch ImageJ: Open ImageJ on your computer. 

2. Open Your Bread Image: Go to File > Open… and select the high-resolution image of your 

bread sample. 

3. Convert to Grayscale: Go to Image > Type > 8-bit to simplify color into grayscale. 

4. Adjust Image Contrast: 

Go to Image > Adjust > Brightness/Contrast. 

Use the sliders to make the mold areas more visually distinct from the bread surface. 

Click apply when mold is visually distinct.  

5. Apply Threshold: 

Go to Image > Adjust > Threshold. 

A red overlay will appear on the selected areas (mold growth). 

Adjust the minimum and maximum sliders until only mold areas are highlighted. 
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Choose Light background and then click Apply to binarize the image (convert to black and 

white). 

6. Analyze Particles (Measure Mold Area) 

Go to Analyze > Analyze Particles. 

Set the Size to exclude small noise. 

Check the boxes for: Display Results and Summarize. 

Click “OK” 

ImageJ will then output: Individual particle areas and a summary with total area and % coverage 

7. Record Total Mold Coverage 

Use the Total Area (mold) and Image Area (whole bread surface) to compute: 

% Mold Coverage = (Total Mold Area / Bread Surface Area) × 100 

 

CHAPTER FOUR 

4.0 RESULTS 

4.1 Dough test results 

4.12 Results for bread treated with Lemon 

Dough Formula Per Sample 
Four dough samples were kneaded with control group having 0% of lemon juice then samples 1, 2 and 3 
having 1.6%, 3% and 6% respectively. A dough test was then performed to assess the optimum lemon 
concentration required.  
 

Ingredient Control Sample 1 (1.6%) Sample 2 (3%) Sample 3 (6%) 

Flour 500g 500g 500g 500g 

Water 300g 292g 285g 270g 

Yeast (dry) 10g 10g 10g 10g 

Salt 8g 8g 8g 8g 

Sugar 20g 20g 20g 20g 
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Fat (e.g., oil) 20g 20g 20g 20g 

Lemon Juice 0g 8g 15g 30g 

 

Table showing results from dough test for samples containing lemon juice 

Stage Control Sample 1 (1.6%) Sample 2 (3%) Sample 3 (6%) 

Dough Handling 

(mixing & kneading) 

Smooth, elastic Slightly softer, easy 

to knead 

Soft, a bit sticky Very soft, slightly 

sticky 

Soft/Firm/Sticky? Firm and well-

structured 

Soft and smooth Soft, slightly sticky Sticky and weak 

structure 

Gluten Development 

(windowpane test?) 

Good stretch Good stretch Slightly weaker Weak, tears easily 

First Proof (1hr) Doubled in size Slightly more rise Moderate rise Slower rise 

Rise (%) 100% 110% 90% 70% 

Texture after proofing Puffy and airy Puffier Less airy Dense and soft 

Final Proof (after 

shaping) 

Normal rise Good rise Slightly reduced Weak rise 

Rise time (min) 45 45 50 60 

Oven spring (during 

baking) 

Excellent Good Moderate Poor 

After Baking Well risen Slightly taller Slightly smaller Low volume 

Volume (visual 

estimate) 

High High Medium Low 

Crumb texture Open and even Open and light Tighter crumb Very tight, slightly 

gummy 

Crust color Golden brown Slightly darker Even, lighter Pale crust 

Flavor Balanced Bright, slightly tangy Noticeably tangy Overly sour, less 

balanced 
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Final Notes Standard 

performance 

Lemon improved 

yeast action slightly 

Flavorful but affected 

rise 

Too much lemon 

weakened gluten 

and slowed yeast 

 

4.13 Results for bread treated with Rosemary extract 

Dough Formula Per Sample 
Four dough samples were kneaded with control group having 0% of lemon juice then samples 1, 2 and 3 
having 2.4%, 3.6% and 8% respectively. A dough test was then performed to assess the optimum 
rosemary extract concertation required.  
 

Ingredient Control Sample 1 (2.4%) Sample 2 (3.6%) Sample 3 (8%) 

Flour 500g 500g 500g 500g 

Water 300g 288g 282g 260g 

Yeast (dry) 10g 10g 10g 10g 

Salt 8g 8g 8g 8g 

Sugar 20g 20g 20g 20g 

Fat (e.g., oil) 20g 20g 20g 20g 

Rosemary Juice 0g 12g 18g 40g 

 

Table showing results from dough test for samples containing Rosemary extract 

Stage Control Sample 1 (2.4%) Sample 2 (3.6%) Sample 3 (8%) 

Dough Handling 

(mixing & 

kneading) 

Smooth and 

elastic 

Slightly firmer Firm but pliable Dense and slightly 

resistant 

Soft/Firm/Sticky? Soft and balanced Slightly firm Firm, less sticky Tight and slightly 

dry 

Gluten 

Development 

(windowpane 

test?) 

Good stretch Very good stretch Strong gluten A bit tough but 

holds well 

First Proof (1hr) Doubled in size Slightly less rise Moderate rise Slower rise 

Rise (%) 100% 90% 85% 70% 

Texture after 

proofing 

Soft and airy Tight but aerated Moderately airy Dense and heavy 
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Final Proof (after 

shaping) 

Risen well Slow rise Moderate Poor 

Rise time (min) 45 50 55 65 

Oven spring 

(during baking) 

Excellent Moderate Low Minimal 

After Baking Good rise Tighter shape Less oven spring Flat appearance 

Volume (visual 

estimate) 

High Medium Medium-low Low 

Crumb texture Open and airy Uniform and 

slightly tight 

Closed crumb Dense and dry 

Crust color Golden brown Light brown Even, dull Pale crust 

Flavor Neutral Herbal and 

pleasant 

Earthy, a bit 

strong 

Overpowering 

herbal taste 

Final Notes Standard dough Rosemary added 

pleasant aroma 

Slightly affected 

yeast 

performance 

Too much 

rosemary juice 

slowed rise and 

hardened crumb 

 
 

4.2 Sensory Evaluation Results Based on Panelist Preferences 

To evaluate consumer preferences for bread treated with various preservatives, a sensory analysis 

was conducted using a panel of ten participants. Each panelist was asked to rate four bread 

samples control (no preservative), calcium propionate, lemon juice, and rosemary extract based 

on four key attributes: texture, aroma, taste, and tenderness. Ratings were assigned using a 10-

point Likert scale, with 1 indicating the least preferred and 10 indicating the most preferred. The 

scores from all panelists per treatment for texture, aroma, taste and tenderness are presented in 

the table below; 

Table showing results from Likert scale for the ten panelists 

    Texture Aroma Taste Tenderness 

Consumer 
1 

T1 7 6 5 1 

T2 1 3 9 2 

T3 2 1 3 5 

T4 5 10 10 3 

Consumer 
2 

T1 3 3 10 9 

T2 3 6 10 2 

T3 3 1 1 6 

T4 7 2 3 5 

T1 10 6 4 7 
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Consumer 
3 

T2 6 7 4 3 

T3 9 5 3 1 

T4 3 8 9 1 

Consumer 
4 

T1 6 3 6 6 

T2 8 5 10 7 

T3 1 3 2 5 

T4 8 4 1 6 

Consumer 
5 

T1 2 3 1 5 

T2 8 1 8 3 

T3 4 6 6 3 

T4 9 3 7 4 

Consumer 
6 

T1 10 10 6 6 

T2 7 10 4 1 

T3 7 10 1 9 

T4 5 9 8 3 

Consumer 
7 

T1 3 9 3 10 

T2 9 1 3 1 

T3 4 4 2 7 

T4 10 5 8 4 

Consumer 
8 

T1 10 7 5 8 

T2 5 2 9 4 

T3 9 8 6 7 

T4 7 9 8 8 

Consumer 
9 

T1 10 5 5 2 

T2 6 2 8 5 

T3 3 1 10 4 

T4 3 10 9 8 

Consumer 
10 

T1 10 2 7 3 

T2 3 9 2 6 

T3 7 6 3 5 

T4 10 6 7 5 

 

Key 

T1= No preservative 
T2= Calcium 
propionate 

T3= Lemon Juice 

T4= Rosemary Extract 
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4.3 Image J results 

3 bread samples were baked, the control group without any preservative, and the other three samples 

having calcium propionate, lemon juice and rosemary extract. Four replicates were made under each 

group, these bread samples were cut transversally, surfaces all exposed and kept under similar 

conditions. High resolution photos were then taken and analyzed using Image J to find the mean 

percentage mold growth per treatment.  

This growth was assessed for a period of 1 week. 

Table showing mean percentage mold growth after a period of 1 week 

Treatment Replicates for mold coverage Mean % Mold 

No Preservative 6.2 

6.19 
No Preservative 5.9 

No Preservative 6.5 

No Preservative 6 

Calcium 

Propionate 
0.5 

0.51 

Calcium 

Propionate 
0.6 

Calcium 

Propionate 
0.4 

Calcium 

Propionate 
0.6 

Lemon Juice 2 

1.89 
Lemon Juice 1.8 

Lemon Juice 1.9 

Lemon Juice 1.7 

Rosemary Extract 1.2 

1.35 
Rosemary Extract 1.4 

Rosemary Extract 1.3 

Rosemary Extract 1.5 
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Some of the bread samples showing mold growth 

 

 

 

 

CHAPTER FIVE 

5.0 DISCUSSION OF RESULTS 
 

5.1 Discussion for Dough test results 

This study investigated the effect of varying concentrations of lemon juice and rosemary extract 

on bread dough quality, baking performance, and sensory attributes. The decision to test different 

percentages 1.6%, 3%, and 6% for lemon juice and 2.4%, 3.6%, and 8% for rosemary extract 

was guided by preliminary taste panels and literature indicating potential performance ranges for 

plant-based preservatives. These concentrations aimed to identify the level at which 

antimicrobial benefits and sensory quality could be maximized without compromising dough 

handling and bread structure. 

Lemon Juice Results 

Across the three tested levels: 

1.6% lemon juice produced slightly softer dough and enhanced yeast activity, resulting in 

improved first proof and oven spring. Bread had a pleasant, mildly tangy flavor with good crumb 

structure. 

3% lemon juice yielded flavorful bread with noticeable tang and moderate rise, though slight 

stickiness affected dough handling. 
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6% lemon juice negatively impacted gluten development and yeast performance, resulting in 

dense, weak dough with poor rise and sour, unbalanced flavor. 

Optimal Concentration: 3% lemon juice was found to balance dough performance, sensory 

appeal, and preservative function. It produced bread with good flavor and acceptable volume 

while avoiding the weakening effects seen at higher concentrations. 

 

Rosemary Extract Results 

The rosemary extract concentrations showed: 

2.4% rosemary improved aroma and maintained moderate dough strength, although proofing was 

slightly slower than the control. 

3.6% rosemary achieved the best balance of gluten structure, flavor, and crumb texture. Bread 

showed a pleasant herbal taste with acceptable rise. 

8% rosemary led to dense, dry dough and flat loaves. Excess extract appeared to harden the 

crumb and suppress yeast activity, causing poor proof and oven spring. 

Optimal Concentration: 3.6% rosemary extract emerged as the most effective level, providing 

robust dough structure and a distinctive herbal flavor without overloading the system or 

damaging texture. 

 

 

Justification for Varying Percentages 

The different concentration ranges for lemon juice and rosemary extract were based on their 

unique chemical compositions and potencies. Lemon juice, being acidic and less concentrated in 

active antimicrobial compounds, required a lower concentration range. Rosemary extract, richer 

in polyphenols and essential oils, had a stronger impact even at small volumes, necessitating a 

more cautious approach to dosing. 

Overall, both preservatives demonstrated viability in bread-making, but their influence on dough 

chemistry differed significantly. Lower levels enhanced bread quality and extended shelf life, 

while higher levels led to structural compromise. These findings support precise concentration 

control when using natural preservatives to ensure both consumer acceptance and functional 

performance. 

 

5.2 Discussion for Sensory Evaluation Results 

The sensory evaluation results provide insights into how rosemary extract and lemon juice 

influenced bread quality compared to calcium propionate and the control (no preservative). 
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Ratings from 10 panelists across four key attributes texture, aroma, taste, and tenderness revealed 

noticeable differences in consumer preferences for each treatment group. 

 

Control (No Preservative) 

Bread samples without preservatives showed mixed performance. While some panelists 

appreciated aspects like texture and taste, the scores for tenderness were generally low. This 

suggests that untreated bread may lack consistency in softness and appeal after storage. 

Calcium Propionate 

This synthetic preservative performed better than the control in terms of dough stability and shelf 

life, as reflected in several panelists’ ratings. However, scores for aroma and taste were relatively 

modest, with some participants noting a lack of flavor depth. This aligns with known sensory 

limitations of calcium propionate, which can preserve but not enhance flavor. 

 

 

 

Lemon Juice 

Lemon juice-treated bread showed strong performance in taste and aroma, often rated higher 

than calcium propionate and the control. The natural acidity appeared to enhance flavor, giving 

bread a pleasant tang. However, ratings for texture and tenderness were inconsistent likely due to 

the effect of lemon juice on gluten structure and crumb softness, especially at higher 

concentrations. 

 Rosemary Extract 

Bread treated with rosemary extract received consistently high scores for aroma and taste, 

particularly from panelists who favored herbal flavor profiles. Its influence on texture was well 

balanced, and tenderness was comparable to or better than the control group. These results 

suggest that rosemary extract contributed positively to both flavor development and mouthfeel. 

 

Conclusion Based on Sensory Evaluation 

Rosemary extract emerged as the most preferred natural preservative overall, especially in 

enhancing aroma, taste, and texture. Lemon juice also delivered desirable sensory qualities, 

particularly in flavor, though its impact on dough softness was more variable. Calcium 

propionate remained effective for shelf-life but lacked in sensory appeal. 

These findings support the use of rosemary extract and lemon juice as clean-label alternatives, 

with rosemary extract showing the highest consumer satisfaction across attributes. Their natural 
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origin and favorable flavor profiles offer promising potential for bakeries aiming to reduce 

synthetic additives while preserving bread quality. 

 

5.3 Discussion of Image J results 

 

This study aimed to evaluate and compare the shelf life of bread treated with rosemary extract 

and lemon juice against that of bread treated with synthetic calcium propionate. Shelf life was 

assessed by measuring visible mold growth (%) on the surface of sliced bread samples over a 

storage period of one week, using ImageJ software. 

Each preservative group, including the control, consisted of four replicates, all stored under 

identical conditions to simulate household environments. The results revealed clear patterns in 

mold development over time, and distinct differences in preservative efficacy among the 

treatments. 

 

 

 RESULTS AT THE END OF THE 1 WEEK STUDY PERIOD 

Control (No Preservative): Extreme spoilage, averaging 6.19% mold growth. 

Calcium Propionate: Minimal growth (0.51%) strong immediate preservation. 

Lemon Juice: Moderate inhibition at 1.89%, showing early antimicrobial potential. 

Rosemary Extract: Slightly better than lemon juice with 1.35% mold coverage. 

 

 All preservatives successfully delayed mold growth, with calcium propionate leading, followed 

by rosemary extract and lemon juice as the last. 

 

 Overall summary of shelf-life performance  
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Rosemary extract, at 1.35%, outperformed lemon juice (1.89%) during the 1 week of study. 

While both natural preservatives extended shelf life compared to the control, rosemary extract 

emerged as the best-performing natural alternative, approaching the effectiveness of calcium 

propionate which remained the benchmark in synthetic preservation. 

 

These findings validate the use of rosemary extract in clean-label bread production and highlight 

its potential as a viable commercial substitute for synthetic preservatives. 

 

 

 

CHAPTER SIX 

6.0CONCLUSION AND RECOMMENDATIONS 

6.1 Conclusion 

This study comprehensively evaluated the performance of two natural preservatives rosemary 

extract and lemon juice in bread formulation and preservation, using calcium propionate as the 

synthetic benchmark.  

For Objective One, results showed that 3.6% rosemary extract and 3% lemon juice produced the 

best dough quality among tested concentrations, balancing gluten development, rise, flavor, and 

overall texture. Higher doses (e.g., 6% lemon juice, 8% rosemary) had adverse effects on dough 

handling and bread structure. 

For Objective Two, sensory evaluations from 10 panelists revealed that rosemary extract-treated 

bread received the highest ratings for aroma, taste, and tenderness. Lemon juice samples were 

also favorably received, especially for taste, while calcium propionate scored lower due to its 

bland sensory profile, despite delivering reliable shelf stability. 

For Objective Three, mold growth analysis using ImageJ showed that rosemary extract 

maintained better shelf-life performance than lemon juice during the 1 week of study. Although 

calcium propionate remained the most effective overall in inhibiting mold, rosemary extract 

outperformed lemon juice and offered a strong natural alternative with consumer appeal. 

In summary, rosemary extract demonstrated the most balanced results enhancing flavor, 

maintaining structural integrity, and extending shelf life making it the most promising clean-label 

preservative among those tested. 

Recommendations  

 Use rosemary extract at 3.6% concentration in future bread formulations to optimize 

dough performance and extend shelf life while enhancing flavor and aroma. 
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 Apply lemon juice at 3% concentration for flavor-rich breads with moderate preservation 

needs, especially in short-shelf-life bakery items. 

 Continue using calcium propionate in commercial settings where long-term mold 

resistance is critical, but consider blending with natural preservatives for improved 

sensory impact. 

 Avoid overly high concentrations (≥6%) of either natural preservative, as these may 

negatively affect gluten structure, dough handling, and bread texture. 

 Educate bakery consumers on the benefits of natural preservatives like rosemary extract 

to build trust and market differentiation in clean-label products. 

 Explore combined natural treatments in future studies for example, pairing rosemary with 

citrus or vinegar to evaluate synergistic effects on shelf life and consumer acceptance. 
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